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About This Particular Macintosh may be uploaded
to any online area or included on a CD-ROM com-
pilation, so long as the file remains intact and unal-
tered, but all other rights are reserved. All informa-
tion contained in this issue is correct to the best of
our knowledge. The opinions expressed in ATPM are
not necessarily those of the entire ATPM staff. Prod-
uct and company names and logos may be registered
trademarks of their respective companies. Thank you
for reading this far, and we hope that the rest of the
magazine is more interesting than this.

Thanks for reading ATPM.
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Welcome

by Robert Paul Leitao, rleitao@atpm.com

Welcome to the December issue of About This Partic-
ular Macintosh! The holiday season has arrived, and
the editors of ATPM wish all of our readers a splen-
did time with family and friends during this special
time of the year. Please join us this month, and ev-
ery month, as we celebrate what we call the “personal
computing experience” and explore the fast-changing
world of personal technology throughout the coming
year.

The Magical Mystery Tour

In November, the music of the Fab Four came to
iTunes and arrived just in time for holiday season
sales. The recordings of the Beatles had been conspic-
uously absent from iTunes, the world’s largest digital
music store. After years of discussions and negoti-
ations, all parties involved reached agreement, and
Apple spared no time and no space on the company’s
Web sites announcing the news.

While much attention has been paid to the volume
of song sales since the debut of the Beatles on iTunes,
there’s a lot more to the story. The group’s music re-
flected the tumultuous cultural and social changes of
the 1960s. The music has special meaning to mem-
bers of the Baby Boom Generation, and bringing the
music of the Beatles to iTunes makes for a powerful
connection with those who remember the Beatles as
an active recording group and the times in which the
music was originally written, recorded, and released.

Watch for increased sales not only of the music of
the Beatles through iTunes but also of Apple’s digital
devices with iPod functionality. The music of the
Beatles is a magical mystery tour through a time of
extraordinary change in our society and remembered
by all of us who experienced the era.

Let It Be?

The release of the iPad has disrupted the PC market.
It’s not that the iPad is a PC replacement. Rather,
it’s a device that transcends the PC paradigm as we
know it today. As large as Apple has become, the
spirit of innovation is inherent in the ethos of the
company. Over the past decade, no company had
done more to transform the ways in which use tech-
nology in our daily lives than Apple. Each of the
company’s products initially released during the past
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ten years, from the iPod to the iPhone to the iPad,
has disrupted established industries and reshaped the
manner in which technology is used and the ways in
which digital content is made available and sold.

The company’s penchant for disrupting markets
and industries through innovation suggests that there
are more new products to come and that nothing
should be let be if there are practical ways to enhance
how we communicate with one another and the world
around us.

The iPad may herald the end of the PC era as we
know it and may usher in a new era of digital content
distribution. Watch for iPad-specific news publica-
tions and the migration of publications currently in
print format to app-style distribution. Reducing the
world’s consumption of newsprint and the need for
fossil-fuel-based delivery of printed publications will
do us all a world of good.

An Analyst’s Life

Moving from the rhythm of music to the flow of num-
bers, the long Thanksgiving weekend provided an op-
portunity to look at Apple’s financial reports with a
different take on the results. To better understand
the ongoing Apple success story, I've posted a quar-
terly comparison of the company’s major cost com-
ponents over the past two fiscal years. While there’s
much talk about Apple’s recent decisions to reduce
gross margins (the difference between the amounts
received on products sold and the costs of manufac-
ture of the products sold), there’s much more to the
story.

Although Apple has become more aggressive on
product pricing, other major cost components such
as operating expenses and tax expense have been re-
duced relative to the growth in revenue. In other
words, Apple continues to increase profits even as
gross margins have been on the decline. You can view
the quarterly comparisons at Posts At Eventide!.

The Annual
Guide

Actually, we don’t have one, nor is a shopping guide
from the editors of ATPM needed in our constantly

ATPM Holiday Shopping

Thttp://www.postsateventide.com/2010/11/apple-quart
erly-comparison-of-costs-and.html

Welcome


mailto:rleitao@atpm.com
http://www.postsateventide.com/2010/11/apple-quarterly-comparison-of-costs-and.html

connected world. There’s no shortage of product
promotions from Apple, and anyone on Apple’s elec-
tronic mailing lists isn’t left wanting for notifications
of new products and holiday gift ideas. We won’t add
to the recommendations but for one new product that
has captured the attention and imagination of Apple
product enthusiasts around the world. ..

The New MacBook Air

For some, the new MacBook Air is appealing due to
its entry price of $999. For others, it’s the slim size
and weight. And for many, it’s the high-resolution
LED-backlit screen. The new MacBook Air may be
the PC industry’s success story of the holiday quar-
ter. The Mac’s unit sales performance continues to
lead the domestic PC industry. As consumers take
an interest in tablet devices, makers of portable PCs
will be under pressure. It’s innovation or elimination
in today’s PC market.

ATPM Wants You!

The editorial staff of ATPM is comprised of talented
writers who started their relationship with our pub-
lication as readers of our monthly issues. When we
say that we “celebrate the personal computing ex-
perience,” we mean it. If you've ever had the urge
to share your personal computing experiences with a
large and influential readership, please contact us at
editor@atpm.com.

Each issue of ATPM, in its variety of formats, is
read by tens of thousands of Apple product enthusi-
asts around the world. Join us today.

Our December issue includes:

Bloggable®

A monthly summary of Wes Meltzer’s blogosphere
news, originating from his delicious.com/bloggable
feed.

MacMuser?: Sophosticated Follower of In-
vasion

Mark Tennent shares a mini-review of Sophos Anti-
Virus software.

2http://www.atpm.com/16.12/bloggable.shtml
Shttp://www.atpm.com/16.12/macmuser—invasion.shtml
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The iPad Chronicles*:
tility

For Robert Paul Leitao, the iPad quickly became
his general-use device, relegating an office PC and
a home Macintosh to specific-use utensils.

The iPad’s Versa-

How To: Updating Multiple Macs®:  the
Combo Update Is Your Friend

Tips for managing multiple Macs in your home, es-
pecially in regard to operating system updates.

How To: Convert Stroke Masks® to Trans-
parency in Adobe lllustrator
A tale of discovery in Adobe Illustrator.

Desktop Pictures: Flowers of Life’
Reader Jay Feuillet shares this month’s desktop pic-
tures featuring flowers at a park in South Florida.

Out at Five®

Matt Johnson’s new series, Out at Five, looks at the
workplace and its boundaries from all angles, revolv-
ing around many of the same characters from his for-
mer series, Cortland.

Review: MAXPower’ 802.11n/g/b Wire-
less USB 2.0 Stick Adapter and Extension
Cradle

An elegant-looking, but difficult and pricey, way of
improving your computer’s wireless reception.

Review: ShareTool 2.1.2%°

This indispensable tool for staying connected to a
computer from a remote location has been updated
to make sharing much simpler, but at the expense of
relying on the developer’s servers for authentication.

4http://www.atpm.com/16.
Shttp://www.atpm.com/16.
html
Shttp://www.atpm.com/16.
.shtml
"http://www.atpm.com/16.
8http://www.atpm.com/16.
9http://www.atpm.com/16.
Onttp://www.atpm.com/16.

12/ipad-chronicles.shtml
12/updating-multiple-macs.s

12/illustrator-stroke-masks
12/desktop-pictures.shtml
12/out-at-five.shtml

12/maxpower . shtml
12/sharetool.shtml
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Copyright © 2010 Robert Paul Leitao. Robert Paul Leitao
is a contributing editor at ATPM and is author of the
Posts At Eventide'' and The iPad Chronicles'? blogs.

http://www.postsateventide.com
2http://www.theipadchronicles.com
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The iPhone as an iPad Companion'

I'm feeling you on the iPad. Just got back from
my yearly visit to Thailand, and my iPad got put
through its paces in the “land of smiles.” I had pic-
tures I shared with Thai friends from previous visits,
I loaded new photos daily, and it was a huge hit when
I showed the locals their pictures old and new. It had
no problem accessing the local hotspots on WiFi, and
I had new and e-mails at my command every morn-
ing at breakfast without having to squint at a tiny
iPhone screen. I saw a iPad ripoff at the local com-
puter place. I had to look twice to realize it was a
knockoff. Imitation being the best form of flattery,
Apple would be very flattered just before they filed
the lawsuit! Every pad device after this owes it suc-
cess to Apple.

—gqwats1957

Holy iPad?: the iPad in the Hands of a

Pastor
Thanks for your comments. I am a pastor and teach
pastors, as well as a long term Mac user (1990). Cur-
rently I use MacBook Pro 15” because I travel so
much, and it is my entire office. But I have also
watched the iPad development, and am leaning to-
ward getting one. (By the way, Accordance might
give you more for your language study, and I don’t
think the copying/pasting is a problem.)
—Rich Shields

Thanks for the comment. I've been very happy

with the iPad, and it’s been great in ministry.

I've heard that about Accordance before. I'm

not sure I'm ready to plunk down extra cash

for another Bible study software. I've invested

quite a bit over the years in Logos. | will take

a look at it, though, in the App Store.

—~Kevin Rossen

Replacing a MacBook Hard Drive

Very interesting article3. What I would like to know
is what degree of difficulty would be involved in re-
placing an internal hard drive in a black MacBook.
I have done this in the older grey Mac and it was

Ihttp://www.atpm.com/16.11/ipad-chronicles-iphone.s
html

2http://wuw.atpm.com/16.11/ipad-pastor.shtml

Shttp://www.atpm.com/16.08/owc-express.shtml
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really easy. However, when I look at the black Mac-
Book with the battery removed, I don’t see what any
simple methods of getting to the innards.

—Richard Scotte

Are you kidding about the internal hard drive?
Turn the MacBook over and remove the bat-
tery. You'll see a metal band with two or three
screws. Back the screws off and remove the
band. You now have access to the memory and
the hard drive. There is a white tab and the
end of the battery bay. Pull it out and give it a
firm tug. You've now removed the hard drive.
Simple!

Swap out the drive in the enclosure and
replace it the way it come out, making sure
you don't put it back in upside down. Give
it a firm push so the drive seats in the SATA
connector. Replace the band and re-install the
battery. You're done!

—Grover Watson

No Smoking Gun*: Re-tooling Dodge and
Burn

This is a very useful non-destructive dodging and
burning technique that I use myself, but don’t be so
hasty to discard Photoshop’s dedicated Dodge/Burn
tools. The overlay blend mode technique lightens and
darkens in a very blunt, linear way that pays no atten-
tion whatsoever to highlights, midtones, or shadows.
The Dodge and Burn tools are much more intelligent
in this respect because they’re working with actual
pixel data. They’re superior for bringing out detail
and deepening shadows without harming midtones or
highlights so severely.

—Tronam

iSkin Keyboard Protector®

I have the same problem. The iSkin is nearly two
years old. It didn’t do this for the first year. I now
work as a nurse practitioner and noticed it after I
started using hand sanitizer a lot while using the key-
board at work. Now it’s there every time I wash the
cover. I think it is degrading. I also cut a tear in the
pad over the left Shift key because of the way I hold
that finger. I'm ready for a new cover, and I'm not

4http://www.atpm.com/14.05/photoshop.shtml
Shttp://wuw.atpm.com/9.01/iskin.shtml
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sure they are still available in the simple basic col-
ors. I can’t find any explanation of what that greasy
substance is caused by.

—Ronda

Making Your Word Processor Work®

A Mac user since 1984 (and Apple before that), I
find ATPM very useful and entertaining. Thank you
for that.

I found the article on word processors particularly
interesting. I started with The Electric Pencil (Apple
][) and tried every new one that came out, finally set-
tling on Word Juggler made by Quark for the Apple

/]
—Chris Albertson

We'd love to hear your thoughts about our publication. We
always welcome your comments, criticisms, suggestions, and
praise. Or, if you have an opinion or announcement about
the Macintosh platform in general, that's OK too. Send your
e-mail to editor@atpm.com. All mail becomes the property
of ATPM and may be edited for publication.

)

Shttp://www.atpm.com/5.06/paradigm.shtml
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Bloggable

by Wes Meltzer, wmeltzer@atpm.com

VideoLAN and Apple! Are Having a Li-
cense Dispute Over VLC

VideoLAN allowed its signature video player, VLC,
be ported to the iPhone by a third party. Apparently
there’s a dispute involving the GPL, under which
VLC is licensed, and Apple’s App Store Terms of
Service. I'm actually kind of surprised this sort of
thing hasn’t come up sooner.

Study?: Developers Will Split Attention

Between More Platforms in 2011

Millennial Media, in conjunction with the Wall Street
Journal, is forecasting that in 2011, developers will
invest more effort on Android and significantly more
on Windows Mobile. Interestingly, they’re forecast-
ing a decrease in developer attention to WebOS, now
owned by HP; they’re also forecasting a 1% decrease
for iOS. For what it’s worth, I’'m not surprised to see
Windows Phone 7 taking up a lot more attention than
WinMo 6.5; it’s a completely new platform with new
UI conventions, and a lot of applications are going to
have to be rewritten. (On the other hand, it’s possi-
ble it will be a flop. Look at WebOS’s market share
numbers. . .and I'm much more impressed by WebOS
than by Windows Phone 7.)

HP’s Slate Isn’t an iPad?,
Touchscreen PC

Computerworld’s Mike Elgan opines that the HP
Slate 500 isn’t anything like the iPad. He makes a
solid point: the Slate is a laptop running a standard
OS with touchscreen enhancements, with all of the
upside (standard applications) and downside (typical
installer pains, battery life, OS mismatches) that
entails. He uses the analogy—ah, transportation
analogies—that the iPad is a bicycle and the Slate is
a motorcycle. It’s no accident that there are an order
of magnitude more bicycles than motorcycles in the
world. Elgan says, “When a new motorcycle comes

It’'s Just a

Thttp://arstechnica.com/apple/news/2010/11/the-vlc-
ios-license-dispute-and-how-it-could-spread-to-and
roid.ars

%http://arstechnica.com/gadgets/news/2010/11/window
s-phone-7-to-rival-ipad-for-developer-attention-in
-2011.ars

Shttp://www.macworld.com/article/155158/2010/10/ipa
d_hpslate.html
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out, the motorcycle magazines don’t ask, ‘Will this
kill the mountain bike?’ It would be absurd.”

Where Does the MacBook Air Fit* in Ap-
ple’s Product Lineup?

John Gruber ponders where the MacBook Air fits in
the product lineup. In the final analysis, he settles
on an interesting hypothesis: the MacBook Air is the
pro iPad, not the lightest MacBook. I come in at the
other end of the spectrum, that eventually the 11"
and 13" MacBook Airs will take over the niche occu-
pied by the lowest-end MacBooks now, in the same
way that the iPod nano was once a niche product
but eventually took over the hard drive-based iPod
classic’s spot in the lineup. But we agree to disagree.
The iPod analogy is a really instructive one, as Ap-
ple’s notebook lineup is now up to four models from
three.

Google’s Android Problem®: Go for Con-

trol or for Market Share

Ben Hookway notes that Google has a problem: un-
like other mobile OS vendors, Google allows a high
degree of carrier and handset-maker customization of
Android. This is one reason they’ve achieved their
market share: some device makers and carriers put a
lot of work into customizing Android. On the other
hand, unlike when you pick up a BlackBerry or Win-
dows Phone 7 handset, the Android experience varies
dramatically from phone to phone or carrier to car-
rier, and I think that weakens the Android brand. Mi-
crosoft is incredibly particular about Windows Phone
7! And Apple, well, what can you say? They make
the phone and OS and sell it on only one carrier. Any-
way, it’s an interesting question to ponder. Hookway
says, “The economic model of handset OEMs neces-
sitates Ul differentiation and Google is taking that
away. For Google to expect Apple-like control on a
fundamentally different business model is just unre-
alistic.” All Google’s mobile money is in search and
ads, not the OS.

4http://daringfireball.net/2010/10/airs_spot_in_lin
eup

Shttp://www.visionmobile.com/blog/2010/10/the-andro
id-ui-dilemma-unify-or-differentiate/
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Could the Mac App Store® Kill Off Soft-
ware Bundles?

On the list of things that hadn’t occurred to me about
the Mac App Store: the possible impact of how Ap-
ple wants to handle sales on software bundles. I've
written about these before; the company selling the
bundle gets developers to discount their software, in
exchange for better exposure. Some work out better
than others for the developers. But this wouldn’t be
possible at all in the Mac App Store, and if that be-
comes the dominant way of buying software, as Ars
points out, this might be going the way of the dodo.

The iPad-ification of the Mac OS”

Ross Rubin, writing for Engadget, speculates about
what the long-run changes to Mac OS X might be, in
light of the big Back to the Mac event. Sure, there’s
a certain amount of hardware convergence: Macs are
getting more like iOS devices, and iOS devices are
getting more like Macs. But Rubin points out that
the changes to the Mac OS may actually be more
radical, as an interface that is more gesture- than
keyboard-and-mouse-driven might someday become
the norm for the Mac, or the single-window screen
(a paradigm that appeared in the original Mac OS
X public beta, believe it or not). It’s a fascinating
question to ponder.

Why Netflix Isn’'t Ready for Android Yet®
John Gruber’s been on a tear lately pointing out how
the lack of centralization and standardization for An-
droid devices leads to some real fragmentation prob-
lems. This is a textbook example: Netflix says that
they can’t roll out Android software, because of the
differences between all the devices, all the possible
versions of the OS still floating around out there,
and the modifications that the OEMs and carriers
can make. They have to use DRM—by contract,
and probably also because of the Digital Millennium
Copyright Act—and there’s no platform-level DRM
support in Android. They plan to roll out support for
specific devices, working on a carrier-by-carrier basis.
In Eric S. Raymond’s famous “The Cathedral and
the Bazaar,” he extols the virtues of letting a thou-
sand flowers bloom, so to speak. But CLI hacker-ware

Shttp://arstechnica.com/apple/news/2010/11/mac-app-
store-might-kill-bundles-but-macgraphoto-set-for-o
ne-more-try.ars

"http://i.engadget.com/2010/11/07/switched-on-the-i
padification-of-mac-os/

Shttp://blog.netflix.com/2010/11/netflix-on-android
.html
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or server-side projects are totally different from core
user experiences like Android. . .and Google allowing
this fragmentation really doesn’t benefit anyone.

Anatomy of How an iPhone App Takes Off°

Robert Scoble takes a survey of the landscape of iOS
apps and the tech press, and he wonders if the entire
ecosystem of iOS and its third-party applications is
liberating itself from the tech press. (Maybe that’s
behind the hostility toward iOS among the techno-
rati?) It’s also worth note that, whether it’s true
or not, developers perceive iOS device users as buy-
ing software, and, for lack of a better word, Android
device users as cheapskates. A colleague of mine is
always extolling how great his Android phone is be-
cause all the apps are free; that doesn’t sound like
it’s fostering a good developer ecosystem to me. So
what if Apache is free? Photoshop isn’t; and neither
are OmniOutliner or CrossWords, to cite some of my
favorite applications for OS X and iOS.

News Corp Creating iPad-Only Newspaper'’

With Recurring Subscriptions
I've been wondering when this would happen, and
who would be the one to create it: News Corp is going
to start an iPad-only newspaper (expanding to other
devices later), which would be based on a recurring
billing system just like regular newspapers. I assume
it will also carry ads, because they will only charge
99 cents a week.

I know the economics of the business well enough
to tell you that even if News Corp gets to keep 69
cents after Apple’s share, and they get a million sub-
scribers, that’s still only $35 million in revenue, or
about the line of a 250,000-circulation daily. Mur-
doch’s not in this to create a digital version of the
Columbus Dispatch. . .he wants to be the Al Neuharth
of the 20th century, to create a tablet analogue to
USA Today. To do that, he needs ads.

Having said that. If this works, it could
completely change the media picture in the post-
industrial Western world.

iOS Is the Future of the Mac OS'!

John Siracusa discusses the future of the Mac OS in
light of the iOS developments. Will Lion really have

9http://scobleizer.com/2010/11/20/is-the-tech-press
-needed-anymore-how-apple-iphone-apps-take-off-now /

Ohttp://www.guardian. co.uk/technology/2010/nov/21/i
pad-newspaper-steve-jobs-rupert-murdoch

Hhttp://www.macworld.com/article/155914/2010/11/mac
ofthefutureos.html
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a single-window focus mode, like the much-maligned
OS X Developer Preview a decade ago, and an im-
proved window-switching system that goes along with
it? What’s the likelihood? Hard to say! But it’s a
really interesting question.

Copyright © 2010 Wes Meltzer, wmeltzer@atpm.com. You
can follow Bloggable in real time at delicious.com/bloggable?.

)

2http://delicious.com/bloggable

ATPM 16.12 12 Bloggable


mailto:wmeltzer@atpm.com
http://delicious.com/bloggable

MacMuser

by Mark Tennent, http://www.tennent.co.uk

Sophosticated Follower of Invasion

The question is, do we care if we pass on Windows
viruses and Trojans? After all, before we installed
the new Sophos Anti-Virus!, we didn’t know that
much of our junk mail arrives with Trojans attached.
ClamXav and iAntiVirus had sat like Bhuddists con-
templating their digital navels as the Trojans slipped
past.

That is the problem for British firm Sophos plc,
which offers Mac users a dependable tool at a great
price, i.e., free. iAntiVirus? and ClamXav? are also
free. ClamXav is the work of another Brit: Mark
Allan, who asks for donations. Mark has been making
the Mac version of ClamAV for years, based on the
open-source anti-virus toolkit for Unix and Windows.

We use Sophos for Windows at work, largely be-
cause it has multi-layered access points for users and
administrators. Which, in effect, means “them” in
IT can keep their jobs by justifying they are needed
to make sure the company server is updated with the
latest virus definitions.

In reality it means machines bog down as they try
to access the servers at the same time as every other
computer in the company. Sophos doesn’t seem to
work 100%, either, or why would a lot of individual
computers suddenly announce they have the lurgi or
some type of virus infection?

After installing Sophos on a Mac, which has
always had an anti-virus installed, Sophos found
a handful of Trojans. Admittedly, they were all
archived e-mail attachments, which Apple’s Mail had
correctly identified as junk mail. The previous anti-
virus packages had been ClamXav and iAntivirus.
ClamXav had never been completely stable, scanned
very slowly and had been replaced with iAntiVirus,
which didn’t like running under 64-bit Mac OS X.
The upshot of this is that Sophos will stay on the
Mac for long-term testing.

The initial scanning of four internal hard disks,
totaling 250 TB, took 36 hours. Since then, Sophos
is invisible unless an infected file is downloaded or
clicked on. Once a threat has been detected, Sophos

Ihttp://www.sophos.com
2http://www.iantivirus.com
Shttp://wuw.clamxav.com
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can delete it, move it to a quarantine folder, or at-
tempt to clean it up.

If files are in a Time Machine archive, Sophos can-
not touch them. They have to be found and deleted
manually. Path names are lengthy (too long to dis-
play in Sophos’s Quarantine Manager) and have to be
searched for in the Sophos log via Console. They can
then be navigated to and deleted in Time Machine
using its toolbar utility. It would be much easier
if clicking on the infected file listed in the Quaran-
tine Manager opened the file’s enclosing folder. Once
deleted, the filenames automatically clear from the
Quarantine Manager list.

There are a few other slightly annoying glitches—
for example, windows and sheets open up in awkward
and unmovable positions—but in daily use Sophos is
easy to use.

Copyright © 2010 Mark Tennent*.
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The iPad Chronicles

by Robert Paul Leitao, rleitao@atpm.com

The iPad’s Versatility

The iPad is the most versatile digital device I've ever
owned. Lighter and easier to carry than a laptop, the
array of comparatively inexpensive application solu-
tions makes the device a winner at both work and
at home. Although I purchased the iPad primarily
for use at home, its versatility has made the device a
work day essential.

iPad and iPhone Integration

One of the delightful aspects of owning and using an
iPad is the easy integration of work processes with the
iPhone. I use OmniFocus' on both the iPad and the
iPhone to manage work projects. Syncing calendars
among my iPad, iPhone, and my Mac at home is a
feature available through Apple’s MobileMe service.

iWork Apps and iCal

I’'m now using Numbers, Pages, and Keynote on the
iPad, and documents from the Mac and iPad ver-
sions of the apps can be transferred easily among de-
vices. Being able to integrate project management,
sync calendars, and share documents among devices
is creating a decidedly lesser role for my office PC in
day-to-day workflow and accomplishments.

The iPad Transcends the PC

I have my iPad with me at all business meetings for
taking notes and entering new contact information.
Because my iPad, iPhone, and Mac at home all sync
through Apple’s MobileMe service, I no longer bother
to enter business contact information into my work
PC. All of my business contact information is read-
ily available on my mobile devices when needed, and
stored on my Mac at home.

Ironically, my iPad has become my general-use
device, while my work PC has become a limited and
specific-use utensil. At home, my Mac is used primar-
ily for content creation, Web site updates, and mod-
erating discussions in the Apple Finance Board. All
other tasks, from following Twitter activity, reading
news, reading books, and monitoring my e-mail ac-
tivity, are performed more conveniently on my iPad.

Ihttp://www.omnigroup.com/products/omnifocus/
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It’s not that the iPad “replaces” a netbook
or notebook PC. The iPad represents a product
paradigm that transcends the netbook and note-
book PC. The iPad’s touchscreen and application
environment are rendering the netbook obsolete.

The iPad and the Era of the iOS App

I have well over 125 iOS apps installed on my iPad
and over 100 apps installed on my iPhone. Including
the iWork application suite, iPad and iPhone versions
of OmniFocus, and a few assorted and inexpensive
apps for home and work, my collective application
investment remains under $125. Matched with pre-
installed apps on the Mac, iPhone, and iPad such
as iCal, Address Book, and iTunes, additional app
purchases provide for specific desired functionality at
attractive prices. Integration of information across
devices extends and enhances functionality among all
of the devices.

I’'m intrigued by the concept of a Macintosh App
Store and what developers will bring to market for
use on the Mac and iOS-based devices. I see op-
portunities for continued integration and sharing of
content among multiple devices.

There’s more to the iPad and its versatility than
I expected when I first purchased the device. The
integrated uses of the iPad and the iPhone are among
the pleasant surprises.

Copyright © 2010 Robert Paul Leitao. Robert Paul Leitao
is a contributing editor at ATPM and is author of the
Posts At Eventide® and The iPad Chronicles® blogs.
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How To

by Sylvester Roque, sroque@atpm.com

Updating Multiple Macs: the Combo Update Is

Your Friend

The holiday season is upon us again. Time to re-
member the things we have to be thankful for and
perhaps do a little gift-giving. If you haven’t al-
ready become one of the many Apple households with
more than one computer!, maybe this will be your
year.

In modern society, there are many good reasons
for being a multi-computer household. I hate to ad-
mit it, but there are probably some good reasons why
one of those machines would be Windows-based. This
month, though, I would like to focus on those of us
who have, or support, multiple Macs. There are some
things that you can do to make the whole process
much more enjoyable and productive.

Setting Up User Accounts

If you've used a Mac for any length of time, you've
probably had to set up at least one user account. The
process is pretty straightforward, and if it’s the initial
setup your Mac will walk you through the process. If
you are going to be setting up or managing multiple
Macs in your home, there are some things you can do
to make things easier.

Not Every User Needs to Be an Administrator
Every Mac must have at least one user account desig-
nated as an administrator account. Without an “ad-
min” account, such basic tasks as installing software
can’t be done. That does not mean, though, that ev-
ery user needs administrator privileges. Do your chil-
dren, for example, understand the system well enough
not to delete or move files that you don’t want moved,
such as your iTunes library? Users who don’t have
at least a basic understanding of OS X could wreak
havoc on a system if they have an admin account.

Create a Troubleshooting Account

Create a troubleshooting account on each Mac. It
doesn’t have to be named “troubleshooting,” but it
does need to be an “admin” account. Don’t use this
account for daily computing; save it for times when

Thttp://mashable.com/2009/10/05/mac-ownership-study
/
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you are having problems. Let’s suppose one of your
programs is behaving erratically when launched from
your main account. Log into the troubleshooting ac-
count and launch the same program. If it runs prop-
erly there, the problem may be a corrupt preferences
file for that program in your main account.

Create the Same User Account on All Machines
The small number of people with regular access to
our Macs have their own user accounts. I've dupli-
cated the accounts across both machines. With this
setup, there are fewer passwords to remember. Ad-
ditionally, there are fewer instances of the operating
system complaining that I don’t have sufficient privi-
leges when I move a file from one system to another. I
usually migrate the user accounts by using Migration
Assistant, but you could create the accounts manu-
ally. If you go the manual route, it is probably best
to create the accounts in the same order on each ma-
chine.

Practice Good Account Security

Encourage users to log out of their accounts when
they are not being used. Without that measure, any-
one with access to the Mac can move or delete files.
Although your family wouldn’t do that deliberately,
accidents happen to the best of us. Leaving the com-
puter logged into a specific user essentially means
that anyone with physical access to the computer can
see and modify that user’s files.

While we are on the subject of account security,
make sure the login information for each user is not
somewhere where just anyone can find it. It does
no good to encourage your family to log out of their
accounts when they are not used if the user name and
password are written on a sticky note attached to the
monitor.

The Root User Is Usually Not Your Friend

One of the concepts that OS X inherits from Unix
is that of the “root user.” This special user has
read /write access to the entire filesystem. Thank-
fully, Apple has this user turned off by default.
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Personally, T wouldn’t enable it unless absolutely
necessary, but before you make that decision, read
Apple’s comments? about the root user.

Advantages of the Combo Updater

When I first started using Macs we had one machine,
and I think the current OS was some version of Sys-
tem 7. At some point between then and the release
of Mac OS X 10.0, I noticed that you could install
a version of the OS that was sort of “generic” and
would boot most machines. It was a great idea for
troubleshooting. T thought we had lost this ability in
Mac OS X until someone on the ATPM staff pointed
out that the “combo updater” serves that purpose
nicely. With Software Update in place to regularly
identify updates, what is the “combo update” and
why use it?

Apple currently uses two general types of OS up-
dates. Individual updates are those identified by Soft-
ware Update and may be specific to each type of Mac.
For the last several updates, the version identified as
appropriate for my desktop Mac Pro has been a differ-
ent size from the one identified as appropriate for my
MacBook Pro. Combo updaters on the other hand?,
“update the base version of a Mac OS X release to
the version specified in the Combo Update, including
all intermediate updates.” Using the current combo
updater, one could go from 10.6.0 to 10.6.5 without
installing each of the point releases.

While you could use an individual update to per-
form the same task, there can be problems. Some-
times an individual updater depends upon some other
component, such as a security update or installer up-
date, already being installed and current. If the right
files aren’t found, and current, they generally must
be installed first before further installations can pro-
ceed. This often means that additional restarts are
needed. This is one of the primary advantages of
the combo update: it updates most of the critical OS
components in one download without worrying about
the sequence of installation.

While the file sizes for combo updaters are some-
times quite large, if you are not good about keep-
ing up with updates they are often the same size
or smaller than downloading all of the component
parts. It seems to me to be so much more Mac-like
to download one file than to download several files
and worry about the installation sequence and possi-
bility of multiple restarts. Repeat that process over

2http://support.apple.com/kb/ht1528
Shttp://www.thexlab.com/faqs/macosxupdates.html
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multiple Macs, and you can see how the combo up-
dater starts to look more efficient.

There is one other advantage of using the combo
updater, but it is not specific to multiple-Mac situa-
tions. I don’t recall ever having an OS update com-
pletely fail to apply properly when run through Soft-
ware Update, but apparently other users have experi-
enced this problem. Many of them have also reported
that applying the combo updater resolved whatever
was preventing the update from installing properly.

Tips for Using the Combo Updaters

After you have started using the combo updaters,
Software Update is still a useful tool. If you've de-
cided that you want to make use of the combo up-
dater, that doesn’t mean that Software Update is use-
less. It can be configured to check for updates auto-
matically, which means you don’t have to remember
to check manually. Once it alerts you that an update
is available, you can always manually download?* the
combo updater.

Make sure to grab the appropriate combo updater
for your situation. Don’t grab the Snow Leopard up-
dater, for example, if you are not running at least
Mac OS X 10.6. There seems to be a somewhat com-
mon misconception about the updates that Apple has
available for download. These downloads cannot be
used to skip an entire series of the operating system.
You must have the base operating system installed
in order for its associated update to work The recent
10.6.5 (Snow Leopard) update will not update a Mac
running 10.5 (Leopard), even if the Mac has enough
horsepower to run Snow Leopard.

In order to keep from downloading the updater
several times, I download it once and move the in-
staller from one machine to another as needed. You
could burn the installer file to a CD or pass it from
one machine to another via the network, but I usu-
ally use a small portable hard drive that I had taking
up space. That’s often faster than burning a CD or
using the network, but use what you have.

Once you have applied the combo updater and
restarted if necessary, run Software Update on each
Mac just to make sure everything is current. This is
a great way to catch minor changes in software that
are specific to a system. My desktop Mac, for ex-
ample, has an older version of iLife, while the laptop
has a current version. By running software update
regularly on each machine, I don’t have to keep track
of which version needs to be updated.

4http://support.apple.com/downloads/
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Final Thoughts

This process could be applied to other software that
is common across all of your Macs, such as iTunes.
The time savings may be a bit less, though, since
these updates are often smaller. If you have a slower
Internet connection, this process can still be a time
saver since you don’t repeatedly download the same
files.

I have focused this month on setup and updating
issues associated with multiple macs in the same
household. The inspiration for this came about with
the recent release of an update that was several
hundred megabytes. There were other issues that I
haven’t addressed, such as keeping data in sync, that
might be addressed in the future if there is some
interest.

Copyright © 2010 Sylvester Roque, sroque@atpm.com.
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How To

by Lee Bennett, Ibennett@atpm.com

Convert Stroke Masks to Transparency in Adobe

lllustrator

The following tutorial was born out of a years-long
struggle I've endured with my office’s current logo.
Make no mistake that I'm not fond of that logo; how-
ever, I'm setting that fact aside for the purposes of
this tutorial.

I'm also giving fair warning that the content of
this tutorial is aimed at those with a reasonable work-
ing knowledge of Adobe Illustrator. This isn’t quite
beginner material, and some of what I'll discuss as-
sumes a high level of familiarity with the application.

Since I am required to utilize the logo, I have often
struggled to work around an issue left by its designer.

The graphic portion of my employer’s logo.

What you see in the image above is what hap-
pens when the logo is placed on top of a color other
than white. The designer created a thick white stroke
around the palm trees in order to have the horizontal
lines stop short and not visibly touch the trees. The
stroke outline covers over the horizontal lines, hiding
them.

This would be fine if the logo were only used on
top of white. Indeed, when it was designed, adminis-
trators had only given thought to printing it on white
paper as stationery. Yes, I can make the stroke a dif-
ferent color if I place the logo on top of a solid-color
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shape, but that workaround is out the window if the
background is multiple colors.

Adobe Illustrator has a command that normally
would solve this problem. When one object is on
top of another, the command can punch the shape of
the upper object out of the lower object. However,
this only works for the filled-in portion of an object.
Strokes (an object’s outline) are ignored. But after
more than a decade of battling this scenario, I've at
last discovered the solution.

Before demonstrating with my office’s logo, I'll
share the technique with a much simpler shape.

Starting with simple shapes.

Beginning with two very simple shapes, the blue
star overlaps the red rectangle. But similar to my
office’s logo, I want a gap around the star so that the
background shows through and the rectangle doesn’t
appear to actually touch the star. You might think
this is an easy fix—just apply a white stroke around
the star at whatever thickness is desired.
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The star now has a white outline.

Voila. The task seems to be complete. But that
outline is not transparent and will show up if I use a
different color background.

I need to point out here that when a stroke is
applied to an object, there is a choice of how that
stroke follows the outline of the object:

1. The center of the stroke can follow the
edge, which means half of the stroke over-
laps the outer edge of the object’s fill and
half extends beyond the object’s fill.

2. The entire stroke follows the inside of the
object’s boundary, completely overlap-
ping the object’s fill at it’s outline.

3. The entire stroke follows just outside of
the object’s boundary.

Normally, I'd want the third option. The first
two will always make the filled portion of the object
appear smaller because the stroke is either partially
or completely overlapping the outer edge of the ob-
ject. For this example, however, I'm going to leave
the stroke set to follow center for two reasons. First,
since the first option is the default way a stroke is
applied, I'm not going to assume that a designer has
changed it to follow the outer edge. Second, there
may be some instances where overlapping the stroke
was intentional, such as a preference for the appear-
ance of an object’s fill when a center stroke is applied.

While simply adding a white stroke, as seen
above, works perfectly fine for my shapes when they
are on a white background, what happens if the
background isn’t white?
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A background color change reveals the stroke mask.

Suddenly, my gap around the star shows up as
the white stroke it really is, instead of making the
rectangle appear to not touch the star. OK, I can fix
this. T'll just change the stroke to the same color as
the background.

Matching the stroke color to the background color.

There! T fixed it! (With apologies to the
There, I Fixed It} Web site.) Or did 1? Suppose I
just got a call from the client who says he wants a
drop shadow on the rectangle.

Thttp://thereifixedit.failblog.org/
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The shadow reveals the stroke mask.

Whups, that doesn’t look right. But maybe it will
be OK. The client called again to say he doesn’t want
the shadow after all, but there’s a pattern that should
be in the background.

Better, but the stroke mask is still visible.

Although it’s not as bad as when the shadow was
applied, the stroke is still visible.

As T explained at the beginning of this tutorial, Il-
lustrator has a command which could be the solution.
It’s called Minus Front, and its function is simple—it
punches the shape of an upper object out of an un-
derlying object. The problem with Minus Front, as
T’'ve said, is that it only works with an object’s filled
area, completely ignoring the stroke. This is exactly
why my office’s logo has given me grief for so many
years, because I didn’t know of any way to punch the
shape of a stroke instead of (or in addition to) the
filled object.
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It turns out that I was thinking about the problem
backwards. Instead of finding a way to use the Minus
Front command on a stroke, which cannot be done,
the solution is to convert the stroke into a filled object
with no stroke, which can punch out another object.

Yes, it’s that simple, and it took me 10+ years to
realize it.

Here’s the procedure. First, select the blue star
which, at this point, has a green stroke around it.
(The color of the stroke makes no difference.) Then,
use the Object > Path > Qutline Stroke command.
This simple function is what eluded me for so long.
After using this command, the object’s stroke will
become a new filled object in the same shape as the
original stroke. If the original object had a filled color,
it will remain as-is, minus the original stroke. Neither
of these objects will have a stroke of its own any more.

Applying the Outline Stroke command.

Enlarge the above image and look closely at the
star’s green stroke. You'll see a thin blue line that
follows the stroke right in the middle of the stroke’s
width. This line represents the outer boundary of
the star’s blue fill, and it depicts what I described
earlier about a stroke being applied as center, where
half overlaps the object’s fill and half is outside of the
object’s fill.

The two objects created by the Outline Stroke
command (the blue-filled star and the green outline)
will be grouped and must be ungrouped to continue.
When this grouped object is selected, head to Object
> Ungroup.

Since the green stroke that was around the star is
now an independent object that is filled and contains
no stroke, it could now be used to punch the shape
out of the rectangle with the Minus Front command.

How To: Convert Stroke Masks to Transparency



But not so fast. This stroke needs to punch out two
objects—the rectangle and a thin outline of the star,
which half of the original stroke covered. If the stroke
had been set to follow the outer edge, this second
punch wouldn’t be necessary.

Since the upper object is eliminated after it
punches another object with the Minus Front com-
mand, two copies of the new stroke object that
was created with the Outline Stroke command are
needed. To get the second copy, select that new
stroke object, select Edit > Copy, and then Edit >
Paste in Back. This will make a copy in the exact
same location as the original, but it will send it
behind the original so it will be waiting for you when
you're ready for it.

If the stroke object needs to be punched out of
even more overlapping objects, just repeat the Paste
in Back command as many times as necessary. How-
ever, if you need to do this more than three or four
times, there is an alternative which I’ll describe later.

After making sure that only the topmost stroke
object and the blue star are selected, head to the
Pathfinder palette (accessible in the View menu if it’s
not already visible), and use the second Shape Mode
button, Minus Front.

PATHFINDER

'

ITI Expand ;_l

%,
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The Minus Front command in the Pathfinder palette.

Now, the star has reduced in size a little bit, rep-
resenting its appearance when the green stroke had
partially overlapped. Now, repeat for the rectangle
by selecting the copy of the stroke object you made
earlier, use the Object > Arrange > Bring to Front
command to make sure it is above the rectangle (al-
though it should already be), Shift-click the rectangle
to select it as well, then use the same Minus Front
command.

ATPM 16.12

21

The stroke object has now punched out a shape from the
rectangle and the star.

There it is. The background pattern shows
through the gap. Click to enlarge the image above
and you’ll see that the red rectangle is selected, and
its control points are visible, which prove the object
really was cut out by the stroke object. This proce-
dure means that I can use a multi-color background,
a drop shadow, or both.

Applying a drop shadow on top of a multi-color background.

There is one small caveat. If the blue star is
moved away, I see that some possibly unwanted por-
tions of the red rectangle are still present.
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The procedure was more difficult for several rea-
sons.

1. The white stroke is actually not part of

Remnants of the punched object.

What has happened here is that only the stroke
object punched through. The filled area of the blue
star wasn’t part of what punched the rectangle. But
this is simple enough to fix. Just click to select the
undesired leftover fill area on the right edge of the
rectangle and delete it.

In order to put the star back in exactly the same
place, I had moved it by using a counted number
of arrow/cursor key nudges, but it doesn’t have to be
moved at all. Alternatively, that leftover object could
have been selected by using the Select > Next Object
Below command.

So, that takes care of the problem for a very sim-
ple design, but in the case of my office’s logo, it was
considerably more tricky. Let’s look at that logo
again:

My office’s logo with the stroke mask visible.
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the visible brown palm trees. Instead,
the designer duplicated the palm directly
beneath and applied the stroke to the
copy. My explanation is that he wanted
the appearance of the center stroke mode
as opposed to an outer stroke, while
avoiding the stroke partially overlapping
the fill area of the palms as it did with
my blue star example.

. The palms were made up of numerous ob-

jects, all with the thick white stroke ap-
plied, but this was probably the easiest
part to fix—I selected all the stroked ob-
jects that made up the palms and used the
Unite command in the Pathfinder palette
to make them a single object. A big plus
to this was that since the stroked palm
graphic beneath the actual palms also had
a fill applied, the fill could be used to
punch the horizontal lines as well as the
stroke. As a result, I wasn’t left with a
remnant to delete as I did above with the
red rectangle.

. The horizontal lines, representing a sun-

rise, were individual stroked lines with no
fill. Inasmuch as strokes cannot be used
to punch a shape out of an object be-
neath, a stroke itself also cannot be the
recipient of such a punch. Even worse, as
can be seen below, the lines were all inside
of a circular mask that is visible when I
switch to Outline view mode.

How To: Convert Stroke Masks to Transparency



Outline view mode reveals that the horizontal lines are
actually all the same width and are being cropped into the
form of a circle by a mask.

4. Complicating matters even further was an
additional layer of stroked objects on top
of both the palms and the horizontal lines.
This added layer was the words for the
name of my office, which I have chosen not
to show here. Suffice to say, after punch-
ing the stroke around the palms out of
the horizontal lines, I then had to repeat
the process to punch the stroke around
the words out of both the palms and the
horizontal lines.

Someone will probably point out that I could
have worked with the horizontal lines as is, but I
chose to temporarily remove them from the clip-
ping mask to make sure I didn’t introduce any
unforeseen problems. Easy to do: select any one of
the lines, right-click (or Control-click if you have a
single-button mouse), and choose Release Clipping
Mask.
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Temporarily eliminating the circular clipping mask.

It is important for me to remember that the object
used to mask the horizontal lines into a circle is still
there. It just isn’t visible because it contains no fill
and no stroke. But if I hover the mouse pointer over
its boundary, it is temporarily highlighted.

\| .‘
._\\
JL

4
a
-
-
-
|
-
-
-
-
-

The “invisible” clipping mask circle will be right there
waiting for me when | need it.

Because working with the commands to select ob-
jects that are beneath other objects is somewhat cum-
bersome to me, I'm going to move the brown palms
out of the way. To make sure they get moved back
into exactly the same position, I held down the Shift
key and pressed the right arrow key 10 times to nudge
the object off to the side a precise amount. (The Shift
key multiplies the nudge amount by a value defined
in preferences.)
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Temporarily moving the palm tree graphic out of the way.

Notice how the horizontal lines touch the palm
tree object when there’s no white stroke to mask
them? Just as before with the blue star, it’s time
to convert the white stroke into a filled object.

Using the Outline Stroke command on the palm tree's stroke
mask.

Same procedure as before: Object > Path > Out-
line Stroke. Then, I can use the same command on
the horizontal lines to change them into filled ob-
jects which can be punched. In this case, they were
grouped together, so I only needed to select one of
them and repeat the Qutline Stroke command.

ATPM 16.12
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Converting the horizontal lines to non-stroked, filled objects.

The next step took me a little while to figure
out. I said earlier that there was an alternative to
making multiple copies of the object I wanted to use
for punching other objects. Rather than do that for
nearly two dozen horizontal lines, I wanted to punch
them all at once. The fact they are all the same
color made things a little easier. If not, I'd have had
to temporarily make them all the same color, then
change them back afterward. After a bit of trial and
error, I discovered that all the horizontal lines needed
to become a compound path.

Converting the horizontal lines into a single, compound path.

There’s the secret. I selected Object > Compound
Path > Make which causes Illustrator to treat all the
selected objects as a single object.

The next step is to punch the palm tree object’s
stroke mask out of the lines. Just as before, I se-
lected the stroke object that was formerly the white
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palm outline, then select the horizontal lines with a
single Shift-flick of any line, then head back to the
Pathfinder palette to use the Minus Front command.

The shape of the palm tree mask has been successfully
punched out of the horizontal lines.

Now, all that remains is to put everything back
where I found it. After nudging the palm trees back
into place with the Shift-Left arrow key, I mouse
around to find the circular mask, click to select it,
Shift-click one of the horizontal lines to select them
as well, and then use the Object > Clipping Mask
Make command.

Reapplying the clipping mask.

At last, the task is complete. Please excuse the
pathetic, hastily made sample background, but it will
suffice. Here’s the logo, sans white stroke mask, with
a gradient background showing through the gap.
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The white stroke mask is now gone, and any background will
now show through the gap between the horizontal lines and
the palm tree.

Contact me with comments on this page if you
have questions. I know the procedure seems rather
convoluted, so I'm happy to try to help if you got
lost.

I still miss FreeHand’s simplicity and always will,
but I am finally beginning to gain a better appreci-
ation of Illustrator’s capabilities, especially since I'm
not sure this stroke-to-object procedure was possible
at all in FreeHand.

Copyright © 2010 Lee Bennett, Ibennett@atpm.com.
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Desktop Pictures

by Jay Feuillet, http://JayFeuillet.com

Flowers of Life

We need new desktop pictures each month. Write!
to us!

This Month’s Desktop Pictures?
This month’s desktop pictures were submitted by
ATPM reader Jay Feuillet. He used a Nikon E2500

to take photos of native flowers in a park in South
Florida.

View Pictures®

%http://www.atpm.com/16.12/flowers-of-1life/

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or
just one fabulous or funny shot, please send it to
editor@atpm.com and we’ll consider publishing it in
next month’s issue.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desk-
top pictures archives®.

Downloading All the Pictures at Once
Some browsers can download an entire set of desktop
pictures at once.

Safari Create a workflow in Automator with these
three actions:

1. Get Current Webpage from Safari.

2. Get Image URLs from Webpage. Get
URLs of images linked from these
webpages.

3. Download URLs.

Imailto: editor@atpm.com

2http://www.atpm.com/16.12/flowers-of-1life/
Shttp://wuw.atpm.com/Back/desktop-pictures.shtml
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iCab Use the Download command to “Download all
linked files in same folder” and configure the
limits to download only the linked images.

OmniWeb Choose “Save Linked > Images...” from
the File menu.

Placing Desktop Pictures

Mac OS X 10.3.x Through 10.6.x
Choose “System Preferences...” from the Apple
menu, click the “Desktop & Screen Saver” button,
then choose the Desktop tab. In the left-side menu,
select the desktop pictures folder you want to use.
You can also use the pictures with Mac OS X’s
built-in screen saver. Select the Screen Saver tab
which is also in the “Desktop & Screen Saver” Sys-
tem Preferences pane. If you put the ATPM pictures
in your Pictures folder, click on the Pictures Folder
in the list of screen savers. Otherwise, click Choose
Folder to tell the screen saver which pictures to use.

Mac OS X 10.1.x and 10.2.x

Choose “System Preferences...” from the Apple
menu and click the Desktop button. With the pop-
up menu, select the desktop pictures folder you want
to use.

You can also use the pictures with Mac OS X’s
built-in screen saver. Choose “System Preferences. ..”
from the Apple menu. Click the Screen Saver (10.1.x)
or Screen Effects (10.2.x) button. Then click on Cus-
tom Slide Show in the list of screen savers. If you
put the ATPM pictures in your Pictures folder, you're
all set. Otherwise, click Configure to tell the screen
saver which pictures to use.

b2

Mac OS X 10.0.x

Switch to the Finder. Choose “Preferences...” from
the “Finder” menu. Click on the “Select Picture...”
button on the right. In the Open Panel, select the
desktop picture you want to use. The panel defaults
to your ~/Library/Desktop Pictures folder. Close
the “Finder Preferences” window when you are done.

Desktop Pictures: Flowers of Life
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Out at Five

by Matt Johnson, mjohnson@atpm.com

Office Drama

HEY. TODD, DID YOU EVER a i IT WAS FLINNY
WATCH *THE OFFICEP" /" WHEN THEY FOCLISED ON

OFFICE HUMOR, BUT THEY

GQLITCKLY DRIFTED INTO
OFFICE

AND THAT STUFF
HOMESTLY JUST

YEAH, ,
SORRY. SHE AND T
WORKED TOGETHER
BEFORE. WE KIND OF
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Office Relationships

WOW, COME
ANGIE, TM HAPPY WE OMN. ANGTE. WE'VE BOTH
YOU FOUND A JOBHERE. \ /” poNT HAVE A WATCHED ENOLIGH MOVIES
BUT THINK WHAT THIS AND TV TO KNOW THERE'S ONLY
MOVE MEANS FOR OUR ONE WAY THIS IS GOING TO
RELATIONSHIP.

3
“WILL YOU MARRY MER*
THIS IS A TACO SAUCE PACKET.
ARE YOU SERIOUS. TODD?

Great Expectations

WHEN YOLI WERE IN WHEN YOUl WERE WHEN YOU FINALLY JOIN
HIGH SCHOOL... IN COLLEGE.. T™ GONNA BE THE “REAL WORLD" ..

SOMEBODY!

I'M GONNA CHANGE
THE WORLD!!

IMGONNASIT INA
FABRIC-COVERED CUBE
AND WATT OUT THE

Wil
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Do It Yourself

THE VALUE IN RELYING
ON THE SERVILES OF A
COMPETENT

MEAN, WORD ART MADE IT

IDID THOSE MYSELF I
REAL EASY..

1 GUESS MRS,
NOODLEMEYER IS
PAYING US AVISIT

OH? WHERE
DID YOL HEAR

NOT HEAR, BRODY.
SMELL. AS IN OLD

THERE MUST BE A
COLD GOING AROUND.
EVERYOMNE IS COUGHING
AND SNEEZING WHEN T

“ TO BOOST SALES
YEARS AGO, WE PROMISED
A LIFETIME REPLACEMENT
WARRANTY AND FREE PHONE
‘SUPPORT ON OLIR EVERY
PRODUCT WE SOLD.

SINCE THEN. IT'S BEEN
INSANELY EXPENSIVE TO
KEEP SLICH A PROMISE, BUT
WEVE FIMALLY FOLIND A

" RETURN THEIR -
MONEY AND TAKE BACK

HIRE ANNINJATO
ELTIMINATE ALL OF OUR

ATPM 16.12
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Keeping Company

HELLOQ,
TECHNICAL SUPPORT. NO,
I DONT HAVE ANY PROBLEMS. I Y |
A WAS JUST LONELY AND WANTED /'
TO TALK ABOUT MY HIP e

Copyright © 2010 Matt Johnson.
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IMS0 6LAD I BOUGHT
‘YOUR PRODUCT TWENTY YEARS

'\ AGO. OTHERWISE I'D HAVE NO ONE |

TO TALK TO EVERY DAY.
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Hardware Review

by Chris Lawson, http://chrislawson.net

MAXPower 802.11n/g/b Wireless USB 2.0 Stick
Adapter and Extension Cradle

Function: USB 802.11b/g/n network
card and range extender.

Developer: Newer Technology®

Price: $50

Requirements: Mac OS X 103
Universal®.

Trial: None

This is the third different USB-based WiFi extender
product I've reviewed for ATPM. The second® was a
vast improvement over the first?, but both had seri-
ous drawbacks. Is the third time the charm?

Unfortunately, no.

And for much the same reason the BearExtender
only warranted a “Good” rating, the MAXPower ex-
tender does too: both devices share a Ralink-built
chipset, and the Mac software from Ralink is atro-
cious. Since I've already addressed most of the short-
comings of the software, I'll simply refer the inter-
ested reader back to the BearExtender review®. (The
drivers have been updated since that review, but the
user interface has not, and remains fundamentally
awful.)

The MAXPower Wi-Fi extender is just a hair bigger than an
old-fashioned pack of Wrigley's gum, but size isn't this
device's problem.

Thttp://newertech.com/products/usb.php
2http://www.apple.com/universal/
Shttp://www.atpm.com/16.07/bearextender .shtml
4http://www.atpm.com/14.03/wi-fire.shtml
Shttp://www.atpm.com/16.07/bearextender.shtml
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Making matters worse is NewerTech’s claim of
“Fully Mac OS X Supported for Plug and Play Set-
Up!” The MAXPower extender comes with a printed
manual and a software CD containing drivers. The
printed manual says, “You can find the Mac OS X
drivers either on the included CD or download them®.
Being of the general philosophy that printed materi-
als or CDs are usually out-of-date, I always check the
Web site for a driver download and assume that’s the
newest software.

Not in this case.

The driver download on the Web site is some three
years old (November 2007), refers only to Mac OS X
10.3 through 10.5, and refers to its newest installer as
being for Tiger (Mac OS X 10.4). The included CD
actually has a 2009 version of the driver software—
two full years newer, but still outdated—that knows
about the existence of Snow Leopard.

There’s a still-newer version” from Ralink on
their own site (click the “RT2870” link). Unfortu-
nately, NewerTech doesn’t refer to this anywhere, so
I had to hit Google to find the manufacturer’s site
and then dig further to find the latest Mac drivers.

Not a great customer experience, guys, especially
from a company with a long history and excellent
name recognition in the Mac market.

Shttp://www.newertech.com/downloads/maxpower_usb_n.
dmg
"http://www.ralinktech.com/support .php?s=3
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The MAXPower device comes with a cap to cover the male
USB connector and easily fits into a pocket.

The hardware itself works fine, though the design
is so-so. The enclosure around the chipset is just wide
enough that plugging the MAXPower device into a
USB port on most Macs or USB hubs will block the
use of both adjacent ports. To be fair, this seems
to be a problem nearly every similar device on the
market has.

If you're using it so that you can get wireless re-
ception out in the Back Forty for the afternoon, you
probably aren’t trying to use another USB device,
a FireWire 800 device, or an external monitor (the
three ports that could be blocked on my 2009-model
MacBook Pro), and you probably don’t care about
losing the use of those ports. If you're using it on
a Mac that’s plugged in on your desk or other semi-
permanent location, you probably don’t mind using
the extension cradle. And having the extension cra-
dle certainly beats not having it.

ATPM 16.12

The USB extension cradle allows you to regain use of
adjacent USB ports by moving the bulky plug away from your
Mac or USB hub. Don't try to sleep in the same room if you

like it dark, though—that blue LED is amazingly bright.

My other quibble with the design is the clear black
plastic used for the enclosure. No, it doesn’t look
clear, but trust me, it’s translucent, so when the blue
activity LED is flickering—which happens constantly
while you’re using it—you see the guts of the device
too. It just looks sloppy and makes the blue LED
even sillier-looking. (Honestly, isn’t this trend played
out by now? Blue LEDs are so 2002.)

That brings us to the ultimate question: is it
worth the price? If you're paying double the price
of a similar device, or nearly so, just for so-called
“Mac-friendly” support and service, well, shouldn’t
the Web site and associated materials actually be
useful and up-to-date? More importantly, shouldn’t
the software actually be Mac-like? If I'm going to
be forced to use awful ports of Windows software, I
don’t see any point in paying Mac premium prices for
the privilege.

Copyright © 2010 Chris Lawson.
is open to anyone.
reviews@atpm.com.

Reviewing in ATPM
If you're interested, write to us at
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Software Review

by Lee Bennett, Ibennett@atpm.com

ShareTool 2.1.2

Function: Secure access to Bonjour ser-
vices on remote networks.

Developer: Yazsoft'

Price: $15 (one license); $25 (two li-
censes); $45 (five licenses)—two li-
censes minimum required for oper-
ation.

Requirements: Mac OS 10.5.8. Universal®.

YERY MICE

Recommended: Universal  Plug-n-Play
capability on host network’s router.

Trial: Fully-featured (maximum of 15
minutes per session)

Last year, I discovered ShareTool as an inexpensive
means to gain access my computer at home from any-
where. Besides file sharing, ShareTool allowed me to
perform remote screen sharing, stream my iTunes li-
brary as if it were on my local network, and more.

ShareTool 2 provides the same features as its
version 1 predecessor, but with a completely over-
hauled approach to initiating a connection. Since my
ShareTool 1.3.1 review® still adequately describes
the benefits of using ShareTool, this review will focus
mostly on the overhauled connection method.

In ShareTool 2, you are no longer required to
either know the host computer’s IP address or use
any means of assigning a static or dynamic domain
name. Instead, Yazsoft now maintains an authenti-
cation server, which initiates a connection by way of
a login e-mail address and password. Once authenti-
cated, the server establishes communication between
the local and host machines, at which point the con-
nection is entirely peer-to-peer. In other words, only
the authentication takes place on Yazsoft’s server.
Afterward, your data and activity securely pass only
between your computer and the one to which you are
connecting.

Ihttp://yazsoft.com/products/sharetool/
2http://www.apple.com/universal/
Shttp://www.atpm.com/15.11/sharetool.shtml
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ShareTool

Please sign up for a free ShareTool account below to continue.

Email Address: |
You'll erter this email addness when connecting 1o your netwerk remotely.

Password:
Enter the password you would like to use for this account.

Confirm:
Confirm your passwoed by entering it again.

-~

r — ™
(_ Existing Account... )

'8 T
g Cancel > Sign Up

Creating a ShareTool account.

Creating a ShareTool authentication account is
simple and automatic. As soon as you begin sharing
for the first time, you are asked to create an account
with an e-mail address and password. Once created,
enabling sharing is a one-click process.

asn ShareTool (=)
(7 =

|%” o L1

Share | Connect Preferences

& Network Sharing: On Stop

Your network is being shared securely in the background. You can quit

ShareTool and your network will remain accessible remotely.

Network Name:

Identifies this network when connecting remotely.
Port Mapping:
v Configure Router Automatically
Port Mapped Manually

VPN Access Only

. Select Custom Port... -

ShareTool automatically configures a router with Universal
Plug-n-Play settings. If UPnP is not supported, ports can be
manually mapped.

On the other end of the connection, after launch-
ing ShareTool, you use the same e-mail address and
password to access the host computer.
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ShareTool

880

Please sign in to your ShareTool account.
Enter the email address & password you selected when sharing your network.

Email Address: sample@sample

Password: Inuu-n-uunul ]

"1 8ign me in automatically next time

Remembering IP addresses and port numbers are a thing of
the past. Connections are now initiated by an e-mail address
and password.

Once authenticated, a list of available computers
is presented. By purchasing a ShareTool license for
each computer in your home, you can access as many
machines as desired from a remote location.

ShareTool

1 1 network found (&
=& Network Name | Computer
@ Home led

Connect Upligns...

Sign Out

A
R —

A list of available computers appears after authenticating
through Yazsoft.

ATPM 16.12

Bonjour Services on the "Home" netwaork.
Double-click any service to launch the appropriate application.

Type
= APPLE FILE SHARING
SCREEMN SHARING
ITUNES MUSIC SHARING
S5H

‘Library_FW

13 Bonjour Services Available y:
+ Show Commaon Services Only

Browse Web Securely...

Remaote Computers

(-

Once a connection to a computer is established, all of its
available services are displayed.

Just as with ShareTool 1, after connecting to a
host computer, available services can be initiated
from a list within the ShareTool application, or via
native places such as the Finder sidebar, iTunes,
iPhoto, etc. You'll have access to file sharing, screen
sharing, printer sharing, iTunes streaming, and more.
ShareTool 2 also supports iTunes’ new Home Sharing
feature. The services window is also where you can
initiate a secure Web browsing session using the Fire-
fox browser. When active, Web traffic is encrypted
and routed through the host computer—great for
keeping your data secure when using public Wi-Fi.

As soon as I learned that ShareTool had switched
to using an authentication server to initiate con-
nections, my very first question was, “How would I
connect to my home computer if the authentication
server was down?” Yazsoft is on record with high
confidence about the uptime on its server. I use
ShareTool numerous times each week to access my
home computer from work. Granted, two months
is not a significant sample period; however, the
authentication server has never been inaccessible
in that time. Just the same, as an advanced fea-
ture, the ability to directly log in with a known
IP address and port number in the unlikely event
of an outage with Yazsoft might make power users
happy. This would also allow the ShareTool to retain
functionality should Yazsoft ever find itself in the
position of having to permanently discontinue the
authentication servers.

In ShareTool 1, after a host computer was set
up for sharing, it was possible to define specifically

Review: ShareTool 2.1.2



which services were shared. For example, if T only
wanted to use ShareTool to access iTunes streaming,
I could have only enabled that service. If someone
managed to acquire my connection information and
log in, file and screen sharing would be inaccessible,
and the would-be intruder would only have access to
see what was in my iTunes library and not have full
access to my computer. I no longer see any means of
limiting which services are shared in ShareTool 2.

On the positive side, ShareTool is now signifi-
cantly easier to set up. Most users will literally not
need to know a single thing about networking or their
router, and still be able to connect to their home com-
puter’s screen, files, iTunes libraries, etc.

Good news for those on a budget or those with
several computers to be made accessible is that Share-
Tool’s price is lower, especially when buying a five-
user license.

My single-item feature wish list from ShareTool 1
remains the same for version 2: an iPhone applica-
tion to access my home computer’s screen. Obviously,
this wish item is now expanded to call for an iPad-
compatible application—preferably universal. And
although T still don’t imagine that Apple would ap-
prove such a thing, if ShareTool could stream my
iTunes library to my iPhone or iPad just as it does to
another computer, capacity on the device would be
of little concern. I wouldn’t even be distraught if this
could only be done over Wi-Fi. Imagine also being
able to send a document from the device to a shared
printer at home. With the ability to interact with a
Mac at home, ShareTool could be the last piece of the
puzzle that would allow someone to give up laptops
entirely and use only an iPad while traveling.

Copyright © 2010 Lee Bennett. Reviewing in ATPM is
open to anyone. If you're interested, write to us at

)

reviews@atpm.com.
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FAQ: Frequently Asked Questions

What Is ATPM?

About This Particular Macintosh (ATPM) is, among
other things, a monthly Internet magazine or “e-
zine.” ATPM was created to celebrate the personal
computing experience. For us this means the most
personal of all personal computers—the Apple Mac-
intosh. About This Particular Macintosh is intended
to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of every-
one who uses a Mac. We hope that we will continue
to be faithful to our mission.

Are You Looking for New Staff Members?
ATPM is looking to add more regular reviewers to our
staff. Though all positions with About This Partic-
ular Macintosh are volunteer, reviewing is a great
way to share your product knowledge and experience
with fellow members of the Macintosh community.
If you're interested, contact ATPM’s Reviews Editor,
Paul Fatula'.

How Can | Subscribe to ATPM?
Visit the subscriptions page?.

Which Format Is Best for Me?

e The Online Webzine edition is for people who
want to view ATPM in their Web browser, while
connected to the Internet. It provides sharp
text, lots of navigation options, and live links
to ATPM back issues and other Web pages.

e The Offline Webzine is an HTML version of
ATPM that is formatted for viewing offline and
made available in a Mac OS X disk image. The
graphics, content, and navigation elements are
the same as with the Online Webzine, but you
can view it without being connected to the In-
ternet. It requires a Web browser.

e The Print PDF edition is saved in Adobe PDF
format. It has a two-column layout with smaller
text and higher-resolution graphics that are op-
timized for printing. It may be viewed online
in a browser, or downloaded and viewed in Ap-
ple’s Preview or Adobe Reader on Macintosh or

Imailto: reviewsQatpm.com

2http://wuw.atpm.com/subscribe
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Windows. PDFs may be magnified to any size
and searched with ease.

e The Screen PDF edition is also saved in
Adobe PDF format. It’s a one-column layout
with larger text that’s optimized for reading
on-screen.

How Can | Submit Cover Art?

We enjoy the opportunity to display new, original
cover art every month. We're also very proud of the
people who have come forward to offer us cover art for
each issue. If you're a Macintosh artist and interested
in preparing a cover for ATPM, please e-mail us. The
way the process works is pretty simple. As soon as we
have a topic or theme for the upcoming issue we let
you know about it. Then, it’s up to you. We do not
pay for cover art but we are an international publica-
tion with a broad readership and we give appropriate
credit alongside your work. There’s space for an e-
mail address and a Web page URL, too. Write to
editor@Qatpm.com for more information.

How Can | Send a Letter to the Editor?
Got a comment about an article that you read in
ATPM? Is there something you’d like us to write
about in a future issue? We’d love to hear from you.
Send your e-mail to editor@atpm.com. We often pub-
lish the e-mail that comes our way.

How Can | Contribute to ATPM?

There are several sections of ATPM to which readers
frequently contribute:

Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of
our favorite places. We think of it as kind of the
ATPM “guest room.” This is where we will publish
that sentimental Macintosh story that you promised
yourself you would one day write. It’s that special
place in ATPM that’s specifically designated for your
stories. We'd really like to hear from you. Several
Segments contributors have gone on to become ATPM
columnists. Send your stuff to editor@atpm.com.

Hardware and Software Reviews
ATPM publishes hardware and software reviews. How-
ever, we do things in a rather unique way. Techno-

FAQ
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jargon can be useful to engineers but is not always a
help to most Mac users. We like reviews that inform
our readers about how a particular piece of hardware
or software will help their Macintosh lives. We want
them to know what works, how it may help them in
their work, and how strongly we recommend it. Please
contact our reviews editor?, before you begin writing,
if you have a piece of hardware or software that you’d
like to review.

Which Products Have You Reviewed?
Check our reviews index* for the complete list.

What is Your Rating Scale?

ATPM uses the following ratings (in order from best
to worst): Excellent, Very Nice, Good, Okay, Rot-
ten. Products rated Good or better are ones that we
recommend. Okay products get the job done. We
recommend avoiding Rotten products.

Will You Review My Product?

If you or your company has a product that you’d like
to see reviewed, send a copy our way. We're always
looking for interesting pieces of software to try out.
Contact reviews@atpm.com for shipping information.
You can send press releases to news@atpm.com.

Where Can | Find Back Issues of ATPM?
Back issues® of ATPM, dating since April 1995, are
available in DOCMaker stand-alone format and as
PDF. In addition, all issues since ATPM 2.05 (May
1996) are available in HTML format.

What If My Question Isn’t Answered
Above?

We hope by now that you've found what you're
looking for (We can’t imagine there’s something else
about ATPM that you'd like to know.). But just
in case you've read this far (We appreciate your
tenacity.) and still haven’t found that little piece
of information about ATPM that you came here to
find, please feel free to e-mail us at (You guessed it.)

editor@atpm.com.
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